Table of Contents

Institute Proposal Module ....................................................................................................................... 3

Searching the Institute Proposal Module for pending proposals............................................................. 3

Printing the Pending proposals report through the Institute Proposal Module ........................................ 4

Using Medusa: Linking various tracking numbers ...................................................................................... 8

Using Medusa to view the Coeus Proposal Development Narrative (attachments) when you have the
Coeus Institute Proposal Number ........................................................................................................ 8

Using Medusa to view the Coeus Proposal Development Narrative (attachments) when you have the
PeopleSoft Award Number ........................................................................................................... 11

Subaward Module .................................................................................................................................. 17

Subawards and Coeus ......................................................................................................................... 17

Viewing subaward invoices entered in Coeus between 12/22/08 and 7/1/14 ......................................... 17

Award Module ........................................................................................................................................ 19

Pre-Prime awards, award budgets, and Coeus ..................................................................................... 19

Viewing pre-Prime awards entered in Coeus prior to 7/1/14 (Printing the Pre-Prime NOA) ............... 19

Viewing pre-Prime award attachments uploaded in Coeus between 7/12/10 and 7/1/14 .................... 21
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing cost sharing in a pre-Prime Coeus award</td>
<td>22</td>
</tr>
<tr>
<td>Viewing a pre-Prime Award Budget</td>
<td>24</td>
</tr>
<tr>
<td>Viewing CITI RCR Training Data in Coeus</td>
<td>26</td>
</tr>
<tr>
<td>Coeus Bugs Quirks list</td>
<td>29</td>
</tr>
<tr>
<td>Getting Help with Coeus</td>
<td>39</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>39</td>
</tr>
</tbody>
</table>
Institute Proposal Module

The Institute Proposal number (IP) is assigned when the Proposal Development proposal has been approved by ORPA. This module includes proposal status information:

- Pending: proposal has been submitted to sponsor; waiting to hear back from the sponsor about their decision (this can take months or sometimes even years)
- Funded: sponsor funded the proposal
- Already awarded: same as funded; this status is used to get around a Coeus bug that occasionally doesn’t let ORPA label the proposal as Funded.
- Declined: sponsor rejected the proposal.
- Inactive: this status is really reserved for mistakes, since we cannot delete IPs from Coeus.

Unless ORPA is told a proposal is declined, the IP status remains as pending and the proposal will appear on the "current and pending" report in Coeus and in the Information Warehouse as pending. If you are notified that a proposal is declined, please tell your ORPA rep so that s/he can change the status to declined. Once the proposal is marked as declined, the proposal will then fall off the C&P the next day.

Searching the Institute Proposal Module for pending proposals

As a department user, you are probably most interested in seeing which proposals are still pending for your dept.

Click on the institute proposal button.

The "Select Proposal" screen appears. From the Status pulldown menu, select Pending and click on Find.

A list of all pending institute proposals for your department appears. Double click on any of them to view them. If any are listed a spending but should be listed as declined, please notify your ORPA rep so that ORPA can change the status to declined.
Printing the Pending proposals report through the Institute Proposal Module

You can print the pending proposals report through the institute proposal module, or you can print the Current and Pending report in the IW.

The pending report in Coeus is real time and can be saved as an Excel spreadsheet, but the format is funky and includes fields (like % effort) that are not used in Coeus.

The Current and Pending report in the IW is day-old data, but it is probably closer to the format you want. It also can be saved to Excel.

There are two ways to run the Pending Support out of Coeus. Here is the fastest way, which saves it as an Excel spreadsheet. You can run the Pending support on any PI; the PI and his/her proposals do not need to be in your dept.
The Search box then appears. Search on the person's name and press Find.

Click on the person's name in the search results list.

From the Edit menu, select "Current and Pending Report"
Click on the Pending Support report tab

Click on the save button

Select pending and click OK
Open your excel spreadsheet

Now you have your pending data for that person.
Note: You cannot save the “current support” out of Coeus as it reflects the current support when Coeus was frozen in mid-June 2014. You must use the Current and Pending Support report in the Information Warehouse instead.
Using Medusa: Linking various tracking numbers

Pre-Prime: Tracking numbers were automatically assigned by Coeus at the following stages. You could look up one number (for example, the subaward number) and find all numbers linked to it with Medusa (the award, PD proposal and IP proposal numbers.)

• When the dept started a Coeus proposal development (PD) proposal, a Coeus tracking number was generated
• When the ORPA rep approved the PD proposal, the Coeus Institute Proposal (IP) number was generated
• If awarded, a Coeus Award number (and PG #) was generated when the ORPA Award Specialists funded the award
• If the award had subawards, a Coeus subaward number was also generated when the ORPA Subaward Administrator added the sub in Coeus.

Post-Prime: The Coeus award and subaward modules are frozen as of mid-June, 2014. Since that date, tracking numbers are assigned as follows:

• When the dept starts a Coeus proposal development (PD) proposal, a Coeus tracking number is generated
• When the ORPA rep approves the PD proposal, the Coeus Institute Proposal (IP) number is generated
• If awarded, the ORPA Award Specialist interfaces the Coeus IP proposal to PS Grants. The PS Grants award number is generated in PS and then feeds back to the Coeus IP module, in the Account number box, at 5am the next weekday morning. The interface also flips the status of the IP from “Pending” to “Funded”.
• If the award had subawards, a PS PO number is generated by the ORPA Subaward Administrator in PS Grants. This number does not feed back to Coeus.

Using Medusa to view the Coeus Proposal Development Narrative (attachments) when you have the Coeus Institute Proposal Number

This quick guide is for users who have the Coeus Institute Proposal number and need to view the Coeus Proposal Development proposal narrative.

Click here to search the Coeus IP module
1. If you know the proposal number, enter the IP # here.

2. You can use an * in place of the zeros.

Otherwise you can search by other criteria, i.e. investigator name.

Highlight the proposal so the row is blue (if you searched for just one proposal the row will already be blue.)

Click on Medusa.
1. Click on the number next to the "colorful building blocks" icon.

NOTE: What if there is more than one row of colorful building block numbers? Start with the one at the bottom.

2. Click on the View button.
Using Medusa to view the Coeus Proposal Development Narrative (attachments) when you have the PeopleSoft Award Number

PeopleSoft award numbers start with AWD (any award funded added after 7/1/14) or CNV (awards that were funded in Coeus and then converted to PS).

If you have the PS award number and need to view the Coeus narrative:
1. Enter the FS award number in the Account Number box.

2. Press Find.

Click on Medusa to search the Coeus IP module.
Click on the View button.

Click on the number next to the "colorful building blocks" icon so that it's highlighted in blue.

What if there is more than one row of colorful building block number? Start with the one listed last.

Now you are viewing the Coeus Proposal Development proposal. Click on the Narrative button.
NOTE: When you are done viewing the narrative, use the yellow folder button in the second toolbar to close:

- The narrative screen
- The proposal development (PD) screen
- Medusa
- The Institute Proposal screen

If you don't close all these screens, & then look up another proposal with the Medusa button, it will display the proposal you previously searched for instead of the one you are currently searching on.

Using Medusa to view the sponsor’s proposal status when you have the Coeus Proposal Development number
You have the Coeus Proposal Development number and want to know if the proposal is Funded by the sponsor, Declined by the sponsor, or still pending the sponsor's decision.

Click on the Proposal Development icon.

1. Enter the Coeus Proposal Development number in the Proposal Number box
(Instead of entering 00019380, you can use "19380, where the * takes the place of the zeros).

2. Click Find

Click on Medusa
Click on the number next to the “two pieces of paper” icon.

This is the sponsor status:
- Funded or Already Awarded (means the same thing)
- Declined (sponsor declined the proposal)
- Pending (still waiting to hear back from the sponsor if they will fund it or not).
Subaward Module

Subawards and Coeus

- Pre-Prime, the Coeus subaward module was used for tracking subawards.
- There was a period of time that CAs and PSPAs and later ICAs were tracked in the Coeus subaward module, but that was assumed by the purchasing dept before Prime go-live.
- Subaward invoices were uploaded in Coeus from 12/22/08 through mid-June 2014.
- Subaward invoices prior to 12/22/08 were entered into ORPA OnBase
- The Coeus subaward module was frozen shortly before Prime go-live on 7/1/14.
- Subaward Purchase Orders for closed subawards were not converted at Prime go-live
  - PO number for closed subawards will not appear on the NOA
- Subaward invoices approved in Coeus prior to 6/20/14 will remain in Coeus
  - The PDFs of the invoices were not converted to PeopleSoft
  - Those pre-Prime invoices do not appear on the Subaward Detail Report and Subaward Invoice Drill
- You can still view all the data above in the Coeus subaward module.
- Post-Prime, all subawards are entered in PS Financials. The Subaward Detail Report and the Subaward Invoice Drill in the IW should be used to view subaward data instead of Coeus. Those reports contain one-day old data.

Viewing subaward invoices entered in Coeus between 12/22/08 and 7/1/14

To view old subaward invoices that were entered in Coeus between 12/22/08 and 7/1/14:

1. Search on the subaward number (or other criteria).
2. Click Find

Use the * in place of zeros.
The table of statuses for subaward invoices is below. At Prime go-live, most invoices were either “Approved” or “Rejected”. Older invoices may have no status or a status of “in progress”. This is because they were entered into the system years ago using a different procedure. Generally, these older invoices (unless you see a second line with a negative amount to “back the money out”) can be considered to be approved.

<table>
<thead>
<tr>
<th>Status</th>
<th>Status Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Progress</td>
<td>If the invoice is new, the invoice has been entered into Coeus by an ORPA coordinator, but the email has not been sent to the PI for approval.</td>
</tr>
<tr>
<td>Sent</td>
<td>The invoice has been entered into Coeus and email has been sent to the PI indicating there is a subaward awaiting approval.</td>
</tr>
<tr>
<td>Approved</td>
<td>The invoice has been approved.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The invoice has been rejected. This line appears in red.</td>
</tr>
<tr>
<td>Rejection Approved</td>
<td>This is the second line that is added to “back the money out” of subaward invoices that were rejected. It is equivalent to the negative amount of money for the invoice. This line appears in red.</td>
</tr>
</tbody>
</table>

**NOTE:** The “Last Updated by” line may not make any sense for invoices entered since 12/22/08 and can be ignored.
Award Module

Pre-Prime awards, award budgets, and Coeus

- Pre-Prime, the Coeus award and award budget modules were used for tracking awards and award budgets.
- The Coeus award and award budget modules were frozen shortly before Prime go-live on 7/1/14.
- You can still view all the award and award budget data for your dept in the Coeus award and award budget modules.
- Awards that were active in FY14 and any closed children associated with active parents were converted from Coeus to PS at Prime go-live.
- What was not converted?
  - The history of every increment and budget
    ▪ The current cumulative amounts (obligated dollars, dates and budget) were converted
    ▪ Anticipated totals and end dates were converted
  - All comments on the Comments tab were not converted
  - All attachments on the Attachments tab were not converted
  - Not every term was converted (terms were condensed at conversion)
  - Payment schedule was not converted
  - All Institute Proposal numbers funding the award were not converted
    ▪ Only the initial IP number was converted
- Post-Prime, all awards and award budgets are entered in PS Financials. The reports in the IW > University Financials – Prime > Sponsored Research folder should be used for viewing award and project budget data. All reports in the IW contain one-day old data, except the NOA which is real-time.

Viewing pre-Prime awards entered in Coeus prior to 7/1/14 (Printing the Pre-Prime NOA)

The easiest way to view old Coeus award information is by printing the pre-Prime NOA out of Coeus. The NOA summarizes the information on each Coeus award tab.
<table>
<thead>
<tr>
<th>Number</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sponsor Award Number</td>
<td>The award number given by the sponsor.</td>
</tr>
<tr>
<td>Award Number</td>
<td>This is the Coeus assigned award number, which is a sequential number. If the number ends in -001, (i.e. 001234-001) it is a parent account or the only account associated with this award. If this number ends in any other number (i.e. 001234-009), it indicates this award is a child, grandchild, or perhaps even a great-grandchild.</td>
</tr>
<tr>
<td>Account Number</td>
<td>This is the 7 digit Project/Grant number, such as 1954. It starts with the three digit unit number and ends with a 4 digit number. If the 4 digit number begins with a 4, the sponsor is a non-government sponsor. If the 4 digit number begins with a 6, the sponsor or prime sponsor is a government sponsor. If the 4 digit number begins with a 3, it’s an internal cost sharing account. Please note that 2000 accounts are not stored in Coeus. Do not use the dash when searching on PG account numbers; Coeus doesn’t understand the dash in this field.</td>
</tr>
</tbody>
</table>

The list of search results will appear. Double click on the line you would like to view. (Note, you can only view awards for the departments in which you have the “View Award” right.)
Viewing pre-Prime award attachments uploaded in Coeus between 7/12/10 and 7/1/14

The July 2010 upgrade added the functionality for Award Specialists to upload award attachments from that point forward. Those attachments were not converted out of Coeus to Prime.

To view the attachments, follow the steps as for printing the NOA in the section above, but instead of clicking on the Printer icon, click on the Attachments tab instead. Then click on the PDF icon for the document you want to view.
The PDF of the NOA will open either in a tab in your browser window or in Adobe. From that separate window, the NOA can be printed or saved.

**Viewing cost sharing in a pre-Prime Coeus award**

As of the fall of 2010, awards with cost sharing have child accounts specifically set up for cost sharing. Cost shared child accounts are Fund 30 accounts, or 3000 accounts.

You can easily view an award hierarchy in Coeus by searching on the Coeus award number (i.e. *7212* in the "award number" box), which will return the entire hierarchy in the search results screen. (In this case, do not search on the "account number" box, which is for project/grant numbers—you could, but it can be tedious to enter all PG numbers in a hierarchy).

Double click on the cost sharing account in the search results to view it. It will have a 3xxx account number and the sponsor name will include "Princeton Internal Cost Sharing".
To view cost sharing details, from the Details menu, select Cost Sharing.

The Cost Sharing screen is then displayed.

- Percentage is not used.
- Type is the cost sharing type.
- Source and destination accounts are listed.
- Amount is the cost sharing amount.
- Comments include details.
1. Depending on how your machine is set up, the PDF of the NOA will open either in a tab in your browser window or in Adobe Acrobat Professional. (To change where you want the Coeus-generated PDF to open, please see the last chapter of this manual). From that separate window, the NOA can be printed or saved.

**NOA:** While the font and spacing of the NOA has changed with 4.4, the content has remained the same.

### Viewing a pre-Prime Award Budget

Pre-Prime award budget data was entered by the ORPA Award Specialists; award rebudgets were generally done by the dept.

- With the award already open in view mode, click on the Money and End Dates tab, then click on the Budget button on the right side of the screen.
- The Budget window will open. Any budget amounts of zero were rebudgets (i.e. money moved from one (or more) cost element(s) to another.)
• Highlight the line you wish to view and then press the Display button.

• Use the scroll bar on the right side to view cost elements that may not fit on the screen at one time.
• Press Close to close the window.

**NOTE**: If Coeus asks you if you want to save changes after you viewed an award budget, the answer is NO! It’s a Coeus bug and it shouldn’t ask you this question. If you answer yes, it will change the last user, date and timestamp to your name and today’s date. Please, just say no!
Viewing CITI RCR Training Data in Coeus

You can view an individual person’s training information in Coeus through the Person table, Training tab. Note that for RCR this will not show you which project this person is charged to, nor will you be able to view training data for more than one person in one screen.

For RCR, a person can be marked as needing training in Coeus if they are charged to a grant with the RCR attribute. If the person has taken the training, the date and method by which s/he completed the training will be indicated (CITI for online CITI training, the registrar’s course number if the course is a RCR course, or “external” if the person took RCR at another institution and that training is accepted by Princeton).

Human subjects IRB training was tracked in Coeus until mid-July 2017, when this data was frozen in Coeus and the CITI human subjects feed was redirected to InfoEd (eRIA) instead. FCOI Training was tracked in Coeus until the fall of 2017, when this data was frozen in Coeus and the CITI FCOI feed was redirected to the home-grown FCOI system. Please contact eRIA staff if you need to see IRB training since mid-July 2017 or FCOI training since the fall of 2017.

Click on the "Maintain Personnel" button (AKA the shady guy) icon.

The Person Search window appears.
Enter the person’s last name in the “last name” box
  a. Alternatively you search by "user name" if you’d like.
  b. You can use a star as the wildcard. So if you could type in just the first few letters of the last name, and then an asterisk, such as har* to find all users who have a last name beginning with Har.

  c. Find the person in the search results list.
Double click on his/her name, and the Person Details screen then appears. Click on the Training tab and look at the rows:

d. For RCR Training:
   i. If Date Requested is filled in but no other data is filled in, the person has been marked as needing RCR training because they were charged to an award with the RCR attribute in PS Grants.
   ii. If the Date Requested, Date Submitted and Score are filled in, the person has taken the RCR training.
      1. Date Requested is the date the data was entered/fed into Coeus.
      2. Date Submitted is the course completion date.
      3. Score is the method of RCR training completion
         a. A Princeton course code
         b. CITI if they took the online CITI training
         c. EXTERNAL if the training was taken at a visiting student’s home institution, or a post-doc’s graduate school.
   iii. Date Acknowledged and Followup Date will always be blank.

e. For IRB Training:
   i. NIH IRB training:
1. The "Date Requested" is the date they completed the NIH IRB training. All other columns will be blank.

ii. For CITI IRB training (mid-July 2017 or prior; please see eRIA for CITI IRB training taken after that date):
   1. The "Date Requested" is the date the training info fed from CITI to Coeus.
   2. "Date Submitted" is the date the person completed the CITI IRB training.
   3. Score is CITI
   4. Other columns are blank.

i. For CITI FCOI Training (fall 2017 or prior; please see RIA for CITI FCOI training after that date):
   (1) The "Date Requested" is the date the training info fed from CITI to Coeus.
   (2) "Date Submitted" is the date the person completed the CITI FCOI training.
   (3) Score is CITI
   (4) Other columns are blank.
## Coeus Bugs Quirks list

Coeus 4.5.1.P2 bugs and quirks list, Updated March 2016

This list contains Coeus quirks, bugs, and FYIs. It contains all bugs reported in the Coeus Proposal Development Guide. CoeusLite Proposal Development quirks are listed at the end of this document.

For all info about Java and Coeus Premium, see the [Coeus Installation and troubleshooting guide](#).

### GENERAL COEUS QUIRKS, ISSUES, FYIs

<table>
<thead>
<tr>
<th>Summary</th>
<th>Description</th>
<th>Last update</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Locked Proposals (locked by your account)</strong></td>
<td>If you try to open your proposal in edit/modify mode, but Coeus won’t let you because the “proposal is locked by &lt;your name&gt;”, you can unlock the proposal yourself.</td>
<td>3/29/16</td>
</tr>
<tr>
<td></td>
<td>• First, go to the Window menu and see if the proposal is listed at the bottom of that list—if it is, then you already have the proposal open and can just click on the proposal number in that list to go back to that window.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If the proposal is not in the Window menu list, then from the File menu, choose “Current Locks”. You will then see your proposal ID in the list. Select the proposal by clicking on it once to highlight it in blue, then click on the Unlock button. Repeat for however many times your proposal is listed in the locked list. You will then be able to edit your proposal.</td>
<td></td>
</tr>
<tr>
<td><strong>Locked Proposals (locked by someone else’s account)</strong></td>
<td>If you try to open your proposal in edit/modify mode, but Coeus won’t let you because the “proposal is locked by &lt;someone else’s name&gt;”, you will have to ask that person to unlock the proposal by closing it. If they do not have Coeus open, you can ask the person to unlock it according to the instructions above, or, if that person is not available, you can contact the Coeus Help Desk at <a href="mailto:coeus_help@princeton.edu">coeus_help@princeton.edu</a> to have it unlocked.</td>
<td>3/29/16</td>
</tr>
<tr>
<td>Topic</td>
<td>Description</td>
<td>Date</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Copying proposals</td>
<td>If you have trouble copying a proposal, there could be a few reasons why. If you were not an aggregator on the original proposal, it will not let you copy the proposal and you will have to ask a coworker who was an aggregator on the original proposal to copy it for you and add you as an aggregator to the copy. If you were an aggregator on the original proposal, there may be a corrupted, uploaded file in the narrative of the proposal you’re trying to copy. If it’s the latter case, usually Coeus will let you copy at least the budget.</td>
<td></td>
</tr>
<tr>
<td>Personnel Names</td>
<td>On 4/16/09, the personnel names in all Coeus modules were updated to not include special characters (i.e. removing accents from characters). This will make searching for personnel names easier in all modules. This also helps us with the system-to-system Coeus to Grants.gov connection, since special characters cause submission issues for Grants.gov. However, at that time, the PeopleSoft Primary name was pulled in instead of the PeopleSoft Preferred name. As of 5/14/09, the Preferred PeopleSoft name without special characters is being used.</td>
<td></td>
</tr>
<tr>
<td>Rebooting Coeus server</td>
<td><strong>Coeus production server is rebooted</strong> every morning at 5am. The reboot takes approximately 2 minutes, so Coeus will be down for that period of time daily.</td>
<td>1/16/09</td>
</tr>
<tr>
<td>No Routing Stops defined</td>
<td>If you submit a proposal and get an error message about “no routing stops defined”, it means no budget has been entered at all. If your proposal has no budget, you still have to mark the budget of $0 as final and complete. Then you should be able to submit the proposal.</td>
<td>1/4/10</td>
</tr>
<tr>
<td>Entering search terms</td>
<td>If you enter a search term on the first line of the search screen in any module, then want to enter a second number in the next row, you would expect that if you press the down arrow, the cursor would go to the next line. In Coeus, the cursor stays on the first line with the first press of the down arrow. You have to press the down arrow twice to get the cursor to move to the second line (or use your mouse to put the cursor on the next line). This problem only happens on the first line of the search screen.</td>
<td></td>
</tr>
<tr>
<td>Search results order</td>
<td>For the Proposal Development &amp; Institute Proposal modules: When a search returns more than one search result, the proposals will be listed</td>
<td>3/29/16</td>
</tr>
<tr>
<td>Proposal hierarchy &amp; narratives</td>
<td>in reverse numerical order, so recent proposals/subcontracts will be listed first.</td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>“This is not a proposal person” message when certifying</td>
<td>Please upload your narratives in your child proposals, preferably child #1, instead of in the parent proposal. This is because if you need to copy the hierarchy, you have to copy the children and create the new parent from one of the copied children. By uploading the narratives in the children, they will get copied, saving you from having to upload them all over again. Also it may be easier to track your narratives if they are all in child #1.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If you try to certify a person, and Coeus says “This is not a proposal person”, remove the person from the Coeus Investigator tab, save, and add them back. Then you’ll be able to certify.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Summary</th>
<th>Description</th>
<th>Last update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uploading narrative files</td>
<td>ORPA is no longer able to upload any files, including the final version of the proposal, to Coeus after the proposal has been approved by ORPA, regardless of sponsor. Therefore, please be sure to upload all components of your proposal into Coeus before routing it for approval.</td>
<td>5/27/10</td>
</tr>
<tr>
<td>Review narrative files in Coeus.</td>
<td>Please view all uploaded files in Coeus to verify that they can be viewed and are not corrupted, before you submit your proposal for approval.</td>
<td>1/12/09</td>
</tr>
<tr>
<td>Unable to edit narrative row</td>
<td>One user reported that Coeus crashes if she adds a narrative row, but then closes the module screen for that row, then uses the Edit button to open the narrative screen for that row, and then presses the Upload button. This happens for any proposal she works on. If this happens to you, the workaround is to add the narrative row, and press the Upload button while you are still in the narrative screen. Then you will be able to upload the narrative file without Coeus crashing.</td>
<td>8/19/10</td>
</tr>
<tr>
<td>Summary</td>
<td>Description</td>
<td>Last update</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>TBA types and red baron</strong></td>
<td>While you can load multiple named people into one cost element line in the red baron (i.e. two professors listed in the red baron on one cost element line for SALRF), each TBA person needs his/her own budget line. It’s a confirmed Coeus quirk.</td>
<td>2/3/11</td>
</tr>
<tr>
<td><strong>TBA types and job code in the red running guy</strong></td>
<td>If there is more than one TBA person, and the TBA people are of the same &quot;type&quot; (i.e. two graduate students are TBA) make sure to change the &quot;Job Code&quot; to be different for each TBA person (i.e. TBA1, TBA2). That is the only way Coeus can determine the quantity of TBA people of that type.</td>
<td>2/3/11</td>
</tr>
<tr>
<td><strong>Problems with Leap Year and the red baron, and budget months</strong></td>
<td><strong>Problem 1:</strong> If you are using the red baron for a graduate student, breaking out the academic and summer months, and a subsequent year is leap year, when you generate your budget periods, double check the red baron in the period containing Feb of the leap year. Typically in the period that includes February of the leap year, the end date for the grad student in the red baron is 6/29 instead of 6/30. This leads to the loss of a day’s salary, and will appear on the Grants.gov form as, for example, 9.97 months instead of 10 months. You will have to manually correct the end date in the red baron for that period.</td>
<td>3/29/16</td>
</tr>
<tr>
<td><strong>Problem 2:</strong> Also, if you use the red baron for other person types and budget academic months, you may see that after generating periods, the person’s end date may extend one day into the next month (i.e. 6/1 instead of 5/31) in the budget year containing Feb of the leap year. You will have to manually correct the end date in the red baron for that period.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Changing costs appends rather than overwrites the previous cost.</strong></td>
<td>Click once on the line item to select it, PAUSE, then click once into the cost box to change the amount. If you highlight the amount of money with your cursor, do not highlight the dollar sign and the amount. If you do highlight the dollar sign and amount together, any numbers you enter will be appended to the current amount instead of overwriting the amount. Avoid this by only highlighting the</td>
<td>12/22/08</td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
<td>Date</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Overhead and/or benefits are not calculating correctly (i.e. it’s not calculated for every budget year or only part of a budget year)</td>
<td>Inside the budget, press the Rates button (it’s on the second toolbar and looks like a percent sign). Press the Sync button. Then save. The OH should now be calculated. The most likely cause for this problem is copying an old proposal or changing the dates on a proposal and not syncing the rates.</td>
<td>3/29/16</td>
</tr>
<tr>
<td>Specifying the OH and UR rate type</td>
<td>If you change the OH rate type to something other than MTDC on the budget summary tab, please be sure to change the UR rate type on the budget summary tab to match the OH rate type chosen. Depending on the scenario, negative underrecovery may be generated, which is fine.</td>
<td>3/5/09</td>
</tr>
<tr>
<td>Negative underrecovery is OK!</td>
<td>When you change the OH rate type to something other than MTDC, please change the UR rate type to match. If you use “MTDC custom” or “TDC custom”, and change your rate to something other than the default of 0% (in either “MTDC custom” or “TDC custom” in the Rates button), Coeus calculates the difference between 0% and whatever rate you chose, which generates negative underrecovery. Negative underrecovery is ok!</td>
<td>4/22/09</td>
</tr>
<tr>
<td>How do I remove positive underrecovery?</td>
<td>First, don’t uncheck the OH or EB rate box for any of your cost elements—doing that will generate underrecovery. Second, when you need to change your rate to something other than 62% on MTDC, select the OH rate type on the Summary tab as “MTDC –custom” or “TDC –custom” as necessary. Change the UR rate type to match. Then in the Rates button (on the second toolbar), scroll down until you see the “MTDC –custom” or “TDC –custom” (whichever you chose) section. Note that there are lines for On and Off campus, for each fiscal year. Change the On and/or Off campus from the default of 0 to whatever the percentage should be, then save. You will see negative underrecovery, which is fine!</td>
<td>4/22/09</td>
</tr>
<tr>
<td>Copying proposals and budgets</td>
<td>If you copy a proposal with a budget where the UR rate type is not MTDC, in the copy, the UR rate type defaults back to MTDC. You have to change the copy’s UR rate type to match the OH rate type.</td>
<td>5/27/10</td>
</tr>
<tr>
<td>Marking budget as complete with cost sharing</td>
<td>Sometimes when you are trying to mark a budget as complete, Coeus tells you that you need to distribute the cost sharing when you actually have already distributed the</td>
<td>6/14/10</td>
</tr>
</tbody>
</table>
cost sharing. If the cost sharing values on the cost sharing distribution screen are correct, then close the budget screen (say no to saving), then click on the budget button and select "Complete" from the "Select Budget" screen instead. Then it should be ok.

| TBA types and job code in the red running guy | If there is more than one TBA person, and the TBA people are of the same "type" (i.e. two graduate students are TBA) make sure to change the "Job Code" to be different for each TBA person (i.e. TBA1, TBA2). That is the only way Coeus can determine the quantity of TBA people of that type. | 2/3/11 |

Budgets periods that are not always 12 months
(such as 7 budget periods in 5 years)

- Make sure to adjust budget periods before adding the cost elements and generating.

- If your budget periods are 12 months and then 6 months, and you enter the 12 month salary for a person in the cost box without using the red baron, and then you generate, the 6 month cost for that person will not be half of what it was in the first 12 months (plus inflation). Instead it will be 4% more of the entire amount entered for the first 12 months. You will have to manually adjust the 6 month amount.

Budget Printing Quirks
<table>
<thead>
<tr>
<th>Summary</th>
<th>Description</th>
<th>Last update</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Budget forms in general</strong></td>
<td>Sometimes if a particular category of cost elements has a lot of line items, and these line items happen to cross a page break, the program actually prints the total cost for that category of cost elements before <em>and</em> after the page break, which is confusing.</td>
<td>5/27/10</td>
</tr>
<tr>
<td><strong>Long titles</strong></td>
<td>Long titles are either truncated or run off the budget page.</td>
<td>5/27/10</td>
</tr>
<tr>
<td><strong>Personnel</strong></td>
<td>Occasionally, some or none of the personnel people print on the MIT budget forms, even if the red baron was used. It is not clear as to the conditions under which this happens for budgets created in 4.4. If a 4.2 budget is printed in 4.4., and the red baron was not used in the 4.2 budget, the personnel will not print.</td>
<td>5/27/10</td>
</tr>
<tr>
<td><strong>Cost sharing summary by period report</strong></td>
<td>If you don’t use the red baron for a personnel item and that item has cost sharing, the cost sharing amount won’t appear on the line item for that person on the form, and won’t be in the cost sharing total nor grand total cost of project for that form.</td>
<td>5/27/10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Summary</th>
<th>Description</th>
<th>Last update</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Distributing cost sharing</strong></td>
<td>In the budget, Edit, Cost Share Distribution window, the “Source Account” is the 5 digit department number that is picking up the cost sharing. If anything other than a 5 digit dept number is entered in this box, that cost sharing row will not print on the PU_CostShareReport.xsl report.</td>
<td>3/29/16</td>
</tr>
</tbody>
</table>

Quirks and error messages while submitting proposal for approval
<table>
<thead>
<tr>
<th>Issue</th>
<th>Description</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock deleted by DB Admin</td>
<td>If you get the &quot;Lock deleted by DB Admin&quot; message when trying to submit, close Coeus, reopen Coeus and it should be ok.</td>
<td>5/27/10</td>
</tr>
<tr>
<td>Narratives are incomplete</td>
<td>If you copy a proposal and then try to submit it, Coeus states the narratives are incomplete, even though they are marked as complete. This is normal behavior; Coeus is asking you to confirm you really don't want to make changes to the narratives. However, sometimes when you start a brand new proposal from scratch, and you mark all narratives as complete, Coeus might tell you that the narratives are incomplete. You’ll go back to the narratives section, see they are complete and try to submit again. Sometimes that is enough, but other times it will still continue to state the narrative is incomplete. We found that setting the status of one narrative from complete to incomplete, then changing it back to complete and pressing save, seems to resolve this issue and you will be able to submit.</td>
<td>5/27/10</td>
</tr>
<tr>
<td>Budget is incomplete</td>
<td>Sometimes when you try to submit a proposal, Coeus will state that the budget is incomplete. You go to the budget and see the budget is actually marked as final and complete. The solution is to change the budget status from complete to incomplete and back to complete, and press save. Then you should be able to submit the proposal.</td>
<td>5/27/10</td>
</tr>
<tr>
<td>Summary</td>
<td>Description</td>
<td>Last update</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Proposal is locked by your account</td>
<td>If you try to modify a proposal and it says it is locked, click on the &quot;Current Locks&quot; link in the upper right corner, then click on each Remove link that you see. This will remove the lock on each part of the proposal and then allow you to continue working.</td>
<td>9/10/10</td>
</tr>
<tr>
<td>Calculating person's salary</td>
<td>Let's say you add a person to a CoeusLite budget, and instead of pressing save, you press calculate. CoeusLite then calculates the person’s salary. When you add the next person, the calculated value for the previous person disappears, and doesn't reappear until you press save.</td>
<td>12/20/10</td>
</tr>
<tr>
<td>Modifying person's base salary after generating periods</td>
<td>If you modify a person’s base salary on the Personnel screen after having Coeus calculate the person’s salary in periods, you have to go into each period for that person and press save on the Personnel Budget screen for EVERY period to get the salaries to recalculate--the salaries do not appear to be recalculated otherwise.</td>
<td>9/10/10</td>
</tr>
<tr>
<td>Problem trying to change budget status from Incomplete to Complete</td>
<td>This is an intermittent bug. Sometimes when the user selects Budget Status &quot;Incomplete&quot;, an error message is displayed that says &quot;An Error Has Occurred: No Message.&quot; If this happens, try marking the budget status as Complete from the Budget Versions window. This bug does not seem to occur there.</td>
<td>9/10/10</td>
</tr>
<tr>
<td>Problem distributing cost sharing</td>
<td>There's an intermittent cost sharing distribution bug in CoeusLite which MIT confirmed is a bug. Sometimes when the user divides cost sharing among several units, CoeusLite says the values don't add to the grand total for cost sharing, when they actually do add up. Other times it seems to work fine. If this</td>
<td>9/10/10</td>
</tr>
</tbody>
</table>
happens, then Coeus Premium must be used to distribute the cost sharing amount.

Anytime there's a decimal quantity of months, it appears as a rounded number. In this example, the number of months should be 2.5 months based on start/end date and %charged/%effort, but it appears as 3.0. At least the detailed Grants.gov budget form lists this as 2.5!

<table>
<thead>
<tr>
<th>Name</th>
<th>Salary Type</th>
<th>%Charged</th>
<th>%Effort</th>
</tr>
</thead>
<tbody>
<tr>
<td>TBA - Undergraduate</td>
<td>08-Student Wages (undergrads)</td>
<td>100.00</td>
<td>100.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Requested Salary($)</th>
<th>Fringe Benefit($)</th>
<th>Funds Requested($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/01/2011</td>
<td>09/15/2011</td>
<td>$3,825.00</td>
<td>$90.00</td>
<td>$3,825.00</td>
</tr>
</tbody>
</table>

This is really 2.5 months

After syncing the budget rates, Lite doesn't prompt the user to save. If the user then clicks away from the rates screen and continues on with the budget, the old rates are used. This is because the rates screen was never saved. Once the user syncing and presses save while on the rates screen, the new rates are used.
Getting Help with Coeus

If you have questions about Coeus, you can:

- Review documentation at http://www.princeton.edu/orpa/coeus/
- Email the Coeus help desk at coeus_help@princeton.edu

Acknowledgements

Large sections of this manual are originally from the Coeus 4.4.1 Premium Proposal Development guide (which has its origins in both the MIT Coeus 4.1 Premium Proposal Development guide and the Princeton Coeus 3.8 award guide) and have been edited, updated, and revised to reflect Coeus 4.5.1.P2 and Princeton procedures.

The enthusiastic participation of the Coeus Team and Coeus testers at Princeton University and our community user testers is greatly acknowledged. We are grateful for the help of the Coeus Consortium members for their advice, guidance, and documentation, in particular the Coeus team and Consortium leaders at MIT, Sam Gannon at Vanderbilt Medical School, and Jennifer Quinn at Brown University.